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The Debian GNU/LINUX Distribution 
Debian® GNU/Linux is a collection of GNU applications compiled and distributed with the Linux® 
kernel. Together they are called a dist, or distribution, of the Linux operating system. 

Debian GNU/Linux is unique. It is among the most complex of the Linux distributions because of its 
flexibility in providing distributions for other hardware architectures and operating system kernels. It 
also standardizes software packaging on all these hardware platforms and kernels while deliberately 
presenting the least amount of upstream source code management and code customization. Both the 
upstream source code maintainers and the users of code from a particular source are often most 
familiar with the defaults provided for their code. 

Therefore, there are few surprises when installing a Debian Linux software package. It generally just 
works the way the programmer intended and works identically on different hardware platforms and 
under different kernels. 

So while Debian provides maximum flexibility and a minimal approach to software management, it 
does provide a means for collecting useful information from a user when a software package is 
installed. 

Optionally, when a software package is created for a Debian distribution, it can include a list of 
questions or a template for the debconf system and a script for asking those questions. Despite its 
name, debconf is not a management or configuration system. It provides a means for a software 
package maintainer or writer to supply a series of questions for a user in a common user interface 
when a software package is installed. The debconf system does not use the answers to configure a 
software package, rather the answers are saved into the debconf database and can be referenced 
by a software packages install script, if the maintainer or software package writer so chooses. 

Debian Mirrors 
Using an analogy, Debian is a huge spinning accretion disk like that surrounding a large black hole. 
It tends to absorb the code from other projects and pack them into packages for distribution. The 
Debian logo is a spinning spiral, which even suggests as much. 

To make the collection and distribution of Debian possible, it is founded on the concept of a 
distribution mirror, which is a common place to collect and share software packages. Local Mirrors 
are copies of all the shared files from one machine to another on the Internet. 

Debian organizes its mirror in a particular way to make sharing the files easier. 

First, Debian recognizes that a mirroring program needs a list of files to copy, so it provides index 
files of all the files for a particular purpose and where there are located on the server. These index 
files are kept in directories named for their purpose. For example, the index files for Debian 3.0 are 
kept in the Debian3.0 directory, and the index files for Debian 4.0 are kept in the Debian4.0 
directory. A mirroring program that wants to copy only the files for Debian 4.0 downloads the index 
files for Debian 4.0, and uses those files to fetch and create its local copies.  

To avoid recopying the index files, the index file directories are kept in a directory named dists and 
the software packages are kept in a directory named pools. The software packages in pools are 
arranged in directories alphabetically beginning with the first letter in the software package name. So 
the a/ directory could have packages for Debian 3.0 and Debian 4.0, but the index files know 
which packages are appropriate for the corresponding distribution. 



3 

 

Debian Distribution 
Initially, Debian did not have an installer. You needed to use another operating system to partition 
and format a hard disk, copy files to it, install a boot loader, and reboot. 

As of version 3.0 Debian has a new installer, d-i for Debian Installer. It comes in several forms, but 
is essentially a kernel, an initial RAM disk image, and a program named Anna. Together they 
bootstrap a minimal Linux installation operating system which then either prompts for user choices or 
reads a configuration file named preseed.cfg to perform the installation. 

After Anna is invoked, it connects to an initial store called the mirror source and downloads micro 
debs to complete its feature set, then installs a minimal installation of the Debian distribution. The 
Anna program then configures the Debian package select library tool apt with sources; next it 
installs a default group of packages called a task. 

For a fully automated installation, the Debian Installer can read its preseed.cfg file from the initial 
RAM disk image or retrieve it from a network source with http. 

Both the initial mirror for Anna and the subsequent apt sources can be served from a local http 
repository. 

Debian Install Media 
Avoid using a network mirror; they are generally for development and organizational-level sharing of 
the Debian package repositories. For most people, it is sufficient and preferable to download a 
simple set of ISO media. 

You can use BitTorrent™, Jigsaw™, HTTP, or FTP to download the ISO media. BitTorrent is the best 
choice for the first-time user. BitTorrent and Jigsaw each distributes the download process across many 
servers and sources, resulting in a faster download for the recipient and a more equitable way to 
share the load across many servers. HTTP and FTP do not distribute the download process and, as a 
consequence, are not as fast. 

Jigsaw download  (jigdo) disassembles ISO images and reuses the pieces to assemble newer ISO 
images while downloading only the changed packages from one release to another (the diffs) to 
make new ISO images. Thus, if you have Debian 4.0r2 ISOs and need to ”freshen” them, running 
Jigsaw download can take those ISO images and use them to create new Debian 4.0r3 ISO images, 
downloading only the differences from network sources. This can result in a huge savings in time and 
bandwidth. 

There are many ways of mirroring package repositories and all but a few use the Debian index files 
and cannot distinguish between packages for one distribution or another, or from one hardware 
platform to another. 

The officially recommended method for making a Debian mirror uses a configurable script named 
anonftpsync. However, configuring it properly can be difficult and often replicates more than one 
distribution’s set of packages. Thus, most early attempts at creating a mirror copy far more packages 
than strictly necessary for the Debian distribution you want to use. 
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ISO media is by far the simpler and more efficient way to get what you want in the smallest amount of 
time possible. 

Note that a complete set of ISO media entails the entire set of packages defined to be part of a 
version and release; it can be quite large. At present, Debian 4.0r3 contains over 18,000 packages. 
The CD-ROM ISO media is spread across 22 ISO images. The DVD ISO media is spread across 3 
ISO images. The size of a complete set of ISO images is about 4.5 GB for each DVD, or 13.5 GB 
total.  If you cannot afford the time to download the media, purchasing physical media online is a 
valid alternative, which you can update using a Jigsaw download session. 

Another approach is to download only the ISO media images you need to get started — generally 
only the first ISO image for install and then discover which ISO images are required for additional 
packages by using the Debian online search engine. 

Finally, after installation and if you have realtime access to the Internet and trust the sources, you can 
configure the dselect package library apt sources to download additional packages from an 
online Mirror. This is not a viable option if you are on a secured network or in a datacenter without 
Internet access and no local Mirror. Consequently, it is good to have a complete local copy of the 
ISO media for your Debian version. 

Prerequisites 
There are a number of prerequisites to the installation of Debian GNU/Linux. After the prerequisites 
are fulfilled, the only thing you need to change from one install target to the next is the target MAC 
address (media access controller hardware addresses): change it to match the MAC address of the 
PXE enabled Ethernet port of the target server. 

Modifying Installation Packages 
The db403-agentless.cfg configuration file is formatted for self-help, meaning you should be 
able to review it and comment or uncomment options to obtain the desired functionality easily at 
install time. 

The most likely thing you would change is to choose a different task for the target. A task 
represents a group of packages to install and represents a familiar typical purpose for the target 
server. You can choose from many possible tasks, such as: 

#tasksel tasksel/first             multiselect standard, desktop 
#tasksel tasksel/first             multiselect standard, gnome-desktop 
#tasksel tasksel/first             multiselect standard, kde-desktop 
#tasksel tasksel/first             multiselect standard, web-server 
#tasksel tasksel/first             multiselect standard, print-server 
#tasksel tasksel/first             multiselect standard, dns-server 
#tasksel tasksel/first             multiselect standard, file-server 
#tasksel tasksel/first             multiselect standard, mail-server 
#tasksel tasksel/first             multiselect standard, sql-database 
#tasksel tasksel/first             multiselect standard, laptop 

After installation, your Debian system’s apt sources are automatically configured to use the 
installation source as a source for installing additional packages. This means that running the 
following command from a console will install any additional package that is an official part of the 
Debian 4.0r3 distribution: 

# apt-get install package-name 
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Some users might prefer to use the new aptitude package browsing, search, and installation tool 
for picking individual or related groups of packages and resolving dependencies automatically. 

Root Login 
By default, the Gnome desktop does not allow the root user to login from the GNOME Display 
Manager (GDM) console. You must login as the user student with password student, then 
proceed to elevate your privilege level to root using su or sudo. 

If you want to enable a root login from the GDM console, choose Desktop (from the upper 
taskbar)→ Administration→Login Window→Security tab. Check the box labeled Allow 
local system administrator login and close the window. You should be able to log out and log 
back in as the root user with the password root. 

If you are using the X Window System on the desktop through the iLO Remote Console, you will find it 
helpful to open a console and enter the following command to synchronize you desktop mouse 
pointer with the VNC console mouse pointer: 

# xset m 1 1 

Add the command to your Xsession startup file to make it a permanent part of your Xsession 
startup procedure. 

Providing PSP-like Support 
The db4.sh script automatically configures the net-snmp agent to permit HP Systems Insight 
Manager (SIM) to connect and obtain enough information to create and maintain an association with 
the server’s management processor. The management processor must have already been discovered 
by the HP SIM through either a Manual Add or a normal Discovery scan of the management 
processors IP address range. 

There is no ProLiant Support Pack distributed for the Debian operating system at this time; thus, 
enhanced performance and hardware management agent functionality are not available. However, 
this agentless install is sufficient to maintain the association between a server and its management 
agent, which will enable you to collect some SNMP data and restart the server or perform SSH 
management tasks. 

Using the HP SIM – ICE-Linux Plug-In to Install Debian 

This section provides a brief introduction to setting up and deploying Debian 4.0 to one ProLiant 
server; the procedure consists of the following steps, each step is described in its own section: 

Step 1: Add a Debian 4.0 Source to Your Repository 
Step 2: Copy or Move the Debian ISO Images into the Directory 
Step 3: Create Directories and Copy ISO Images 
Step 4: Download the Debian Installer 
Step 5: Enable the Debian Installer to Accept a MAC Address 
Step 6: Edit the preseed.cfg Configuration File 
Step 7: Create Archive for the Kernel 
Step 8: Modify ICE-Linux JBOSS Web Server 
Step 9: Add Debian 4.0 Installation Configuration File 
Step 10: Create a Default Custom OS preseed.cfg Configuration File 
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Step 11: Create Agentless Installation Association Configuration Script 
Step 12: Installing Debian4-i386 on a Target System 

Step 1: Add a Debian 4.0 Source to Your Repository 
Use the following procedure to add a Debian 4.0 source to your repository. 

1. If your /opt/repository/custom directory is mounted from an NFS share, unmount it. 
2. Use either BitTorrent or Jigdo to collect the three DVD ISO images for Debian 4.0. 
3. Start HP SIM. 
4. Select the HP SIM Options →Manage ICE-Linux Repository... menu item. 

5. Select  New. 
6. Select Custom OS for the Item type menu item, then select Next>. 
7. Enter the following information for each text field: 

Item type:    Custom OS 

Name          Debian4-i386  

Description   Debian Etch Release 

Vendor        GNU 

Version       4.0 Release 3 

Architecture  i386 

Item location Local 

Kernel name   Linux 

RAM disk name initrd.gz,Debian4-i386Boot/iram1.gz 

8. Select Save. 

9. Select Ok. 

Step 2: Copy or Move the Debian ISO Images into the Directory 
Copy or move the DVD ISO images for Debian 4.0 into the  
/opt/repository/custom/Debian4-i386 directory. 
 

Step 3: Create Directories and Copy ISO Images 
In general, loopback mounting is possible; however, the default kernel of many distributions only 
permits 8 loopback mounts at a time. Reserve these resources for other purposes: 

HP recommends that you create directories and copy the contents of the ISO images into them as in 
the following procedure: 

1. Change to the directory specified in Step 2: Copy or Move the Debian ISO Images into the 
Directory: 

# cd /opt/repository/custom/Debian4-i386 

2. Make the directories for the mountpoint for the DVD and for the contents of the DVDs: 

# mkdir cdrom ; mkdir DVD{1,2,3} 
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3. Mount the first DVD: 

# mount -o loop debian-40r3-i386-DVD-1.iso cdrom 

4. Copy the contents of the DVD into the DVD1 directory: 

# cp -ar cdrom/* DVD1 

5. Unmount the first DVD: 

# umount cdrom 

6. Mount the second DVD: 

# mount -o loop debian-40r3-i386-DVD-2.iso cdrom 

7. Copy the contents of the DVD into the DVD2 directory: 

# cp -ar cdrom/* DVD2 

8. Unmount the second DVD: 

# umount cdrom 

9. Mount the third DVD: 

# mount -o loop debian-40r3-i386-DVD-3.iso cdrom 

10. Copy the contents of the DVD into the DVD2 directory: 

# cp -ar cdrom/* DVD3 

11. Unmount the third DVD: 

# umount cdrom 

Step 4: Download the Debian Installer 

The netboot version of the Debian installer is not on the ISO media. You must download it and copy it 
to the /opt/repository/boot/Debian4-i386Boot directory. 

• A  plain text mode version of the installer or a graphical installer version is available from the 
following site:  

http://http.us.debian.org/debian/dists/etch/main/installer-
i386/current/images/netboot 

• To obtain  the graphical version, run the following commands: 

# cd /opt/repository/boot/Debian4-i386Boot 

# wget http://http.us.debian.org/debian/dists/etch/main/installer-
i386/current/images/netboot/gtk/debian-installer/i386/linux 

http://http.us.debian.org/debian/dists/etch/main/installer-i386/current/images/netboot
http://http.us.debian.org/debian/dists/etch/main/installer-i386/current/images/netboot
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# wget http://http.us.debian.org/debian/dists/etch/main/installer-
i386/current/images/netboot/gtk/debian-installer/i386/initrd.gz 

Step 5: Enable the Debian Installer to Accept a MAC Address 

Typically, a server has many network interfaces.  The Debian installer expects a kernel name for the 
Ethernet interface to use for installation.  The kernel does not always give the same kernel name to an 
Ethernet interface from one boot cycle to the next.  MACs for Ethernet interfaces are used to 
distinguish one Ethernet interface from another consistently across boot cycles.  To enable the Debian 
Installer to accept a MAC address for the network interface to use for installation, create a special file 
called iram1.gz; the procedure follows: 

1. Change to the Debian4-i386Boot directory: 

# cd /opt/repository/boot/Debian4-i386Boot 

2. Create a directory named iram and change to it: 

# mkdir iram ; cd iram 

3. Invoke the text editor of your choice to create a file named macfinder. 
4. Copy the following bash script and paste it into the text editor’s buffer. 
 
#!/bin/bash 
# find the mac address in kernel args 
mac=`expr "$(cat /proc/cmdline)" : ".*xdevice=\([^ ]*\)"` 
 
# load the net drivers 
for i in pcnet32 e1000 bnx2 tg3 
do 
  modprobe $i 
done 
 
# find the device with the mac address 
eth=`ifconfig -a | grep -i $mac | cut -d" " -f1` 
 
# find the preseed url in kernel args 
url=`expr "$(cat /proc/cmdline)" : ".*preseed=\([^ ]*\)"` 
echo "----------------------------------" 
echo "Hewlett Packard - DEBN4 mac finder" 
echo "----------------------------------" 
echo "mac  = $mac" 
echo "eth  = $eth" 
echo "url  = $url" 
echo "----------------------------------" 
 
# set the interface to use 
echo "d-i netcfg/choose_interface    select $eth" >> preseed.cfg 
 
# fetch network preseed cfg 
echo "d-i preseed/url                string $url" >> preseed.cfg 
 
# reset the init cmd 
init='busybox init' 
# start the original initrd init process  
exec $init 

5. Save the macfinder file and exit the text editor. 

http://http.us.debian.org/debian/dists/etch/main/installer-i386/current/images/netboot/gtk/debian-installer/i386/initrd.gz
http://http.us.debian.org/debian/dists/etch/main/installer-i386/current/images/netboot/gtk/debian-installer/i386/initrd.gz
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Step 6: Create the preseed.cfg Configuration File 

In this section you create a precursor preseed configuration file. 

1. Invoke the text editor of your choice. 
2. Copy the following text. 

 
# locale 
########################################## 
d-i debian-installer/locale    string en_US 
d-i console-keymaps-at/keymap  select us 
 
 
# network 
########################################### 
d-i netcfg/wireless_wep        string 
d-i netcfg/get_nameservers     string 
d-i netcfg/dhcp_timeout        text 60 

3. Paste the text into the text editor buffer. 
4. Save it with the file name preseed.cfg. 
5. Exit the text editor. 

Step 7: Create Archive for the Kernel 
Create an archive of the files the kernel will know how to open, and which will be integrated with the 
original initramfs file named initrd.gz at kernel start time: 

1. Change to the iram directory:  

# cd /opt/repository/boot/Debian4-i386Boot/iram 

2. Extend executable permission to the macfinder file:  

# chmod +x macfinder 

3. Create the archive file and compress it with the GZIP program: 

# find . | cpio -o -H newc | gzip > ../iram1.gz 

Step 8: Modify ICE-Linux JBOSS Web Server 
Modify the ICE Linux JBoss web server to support 1000 connections per thread before restarting a 
web server connection with a client. Also, configure the JBoss web server to run on port 80 by 
modifying the port in the /opt/mx/icle/icle.properties file (the JBoss web server does not 
need to run on port 80 if the URL addresses in these scripts are appended with colon and port 
60000, the JBoss web server default port). 

Use the following procedure: 

1. Stop HP SIM with the mxstop command. 
2. Use the text editor of your choice to edit the  
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/opt/mx/jboss/server/icle/deploy/jboss-web.deployer/server.xml file. 

3. Locate the specification for Connector Port 60000 as shown here: 

<Connector 
port=60000 

 
 
4. Make the following changes in the server.xml file: 

a) change the port=6000 to port=80 
b) Insert a line to assign a value of 1000 to the maxKeepAliveRequests variable. The 

maxKeepAliveRequests number specified is an indication of the number of packages to 
be installed. If you need to add a large number of additional packages, increase this value. 

The following reflects the changes to the server.xml file: 

<Connector 
port=80 
... 
maxKeepAliveRequests="1000" 
... 
/> 

 
5. Save the server.xml file. 
6. Edit the /opt/mx/icle/icle.properties file to change the association of the 

REPOSITORY_HTTP_PORT variable from  REPOSITORY_HTTP_PORT=60000 to 
REPOSITORY_HTTP_PORT=80 to match the change in step 4a. 

7. Save the icle.properties file and exit the text editor. 
8. Restart HP SIM with the mxstart command. 

Step 9: Add Debian 4.0 Installation Configuration File 

Add a Debian 4.0 Installation configuration file to your repository as follows: 

1. Select the HP SIM Options→ Manage ICE-Linux Repository... menu item. 
2. Select New. 
3. Select Installation configuration file (Kickstart/AutoYaST) for the Item type menu item, 

then select Next>. 
4. Enter the following information for each text field: 

Item type:         Installation configuration file 

Name               db403-agentless  

Description        Debian Etch Release 

5. Select Custom OS for the Operating Systems menu. 
6. Select Save. 
7. Select Ok. 

Step 10: Create a Default Custom OS Configuration File 
Use the following procedure to create the default OS configuration file for Debian4-i386.   
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1. Determine the HP SIM server that provides service to the target system you want to install Debian 
on.  

Determine the (numeric) IP address of the Ethernet port of that HP SIM server. You will need the IP 
address in step 5. 

2. Change directory to the location in the repository for the installation configuration file added in 
Step 9: Add Debian 4.0 Installation Configuration File: 

# cd /opt/repository/instconfig/db403-agentless 

3. Use the text editor of your choice to open the db403-agentless.cfg configuration file. 
4. Copy the following text and paste it into the text editor’s buffer. 

# mirror 
########################################### 
d-i mirror/country          string enter information manually 

d-i mirror/http/hostname    string HP_SIM_Server_IP_Address  
d-i mirror/http/directory   string /custom/Debian4-i386/DVD1/debian 
d-i mirror/protocol         string http 
d-i mirror/http/proxy       string 
d-i mirror/suite            string stable  
# partition 
########################################### 
 
d-i partman-auto/disk                          string /dev/cciss/c0d0 
#d-i partman-auto/disk                         string /dev/discs/disc0/disc 
d-i partman-auto/init_automatically_partition  select Guided - use entire disk 
d-i partman-auto/purge_lvm_from_device         boolean true 
d-i partman-auto/method                        string regular 
#d-i partman-auto/method                       string lvm 
#d-i partman-lvm/confirm                       boolean true 
d-i partman-auto/choose_recipe                 select All files in one partition  
#                                              (recommended for new  users) 
d-i partman/confirm_write_new_label            boolean true 
d-i partman/choose_partition                   select Finish partitioning and 
write changes to disk 
d-i partman/confirm                            boolean true 
 
# time 
###########################################  
d-i clock-setup/utc               boolean true 
d-i time/zone                     string US/Central 
 
# accounts 
########################################### 
# root 
d-i passwd/root-login             boolean true 
d-i passwd/root-password          password root 
d-i passwd/root-password-again    password root 
 
# mortal 
d-i passwd/user-fullname          string James T. Kirk 
d-i passwd/username               string student 
d-i passwd/user-password          password student 
d-i passwd/user-password-again    password student 
 
# apt 
########################################### 
d-i apt-setup/local0/comment      string debian-40r3-i386-DVD-1 

d-i apt-setup/local0/repository   string http://HP_SIM_Server_IP_Address/custom/ 
Debian4-i386/DVD1/debian stable  main (continued from previous line) 
 
d-i apt-setup/local1/comment      string debian-40r3-i386-DVD-2 

d-i apt-setup/local1/repository   string  http://HP_SIM_Server_IP_Address/custom/ 

http://hp_sim_server_ip_address/custom/
http://hp_sim_server_ip_address/custom/
http://hp_sim_server_ip_address/custom/
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Debian4-i386/DVD2/debian stable  main (continued from previous line) 
 
d-i apt-setup/local2/comment      string debian-40r3-i386-DVD-3 

d-i apt-setup/local2/repository   string http://HP_SIM_Server_IP_Address/custom/ 
Debian4-i386/DVD3/debian stable  main (continued from previous line) 
 
d-i apt-setup/security_host       string 
d-i apt-setup/security-updates    boolean false 
 
d-i debian-installer/allow_unauthenticated string true 
 
# popcon 
########################################### 
popularity-contest popularity-contest/participate   boolean false 
 
# task 
########################################### 
tasksel tasksel/first              multiselect standard, desktop 
#tasksel tasksel/first             multiselect standard, gnome-desktop 
#tasksel tasksel/first             multiselect standard, kde-desktop 
#tasksel tasksel/first             multiselect standard, web-server 
#tasksel tasksel/first             multiselect standard, print-server 
#tasksel tasksel/first             multiselect standard, dns-server 
#tasksel tasksel/first             multiselect standard, file-server 
#tasksel tasksel/first             multiselect standard, mail-server 
#tasksel tasksel/first             multiselect standard, sql-database 
#tasksel tasksel/first             multiselect standard, laptop 
 
# pkgs 
########################################### 
d-i pkgsel/include                string snmpd 
 
# xorg 
########################################### 
xserver-xorg xserver-xorg/autodetect_monitor               boolean true 
xserver-xorg xserver-xorg/autodetect_video_card            boolean false 
xserver-xorg xserver-xorg/config/device/driver             select ati 
xserver-xorg xserver-xorg/config/device/identifier         string ATI 
Technologies Inc ES1000 rev 2 
xserver-xorg xserver-xorg/config/monitor/selection-method  select medium 
xserver-xorg xserver-xorg/config/monitor/mode-list         select 1024x768 @ 60 
Hz 
xserver-xorg xserver-xorg/config/display/modes             multiselect 1024x768, 
800x600 
 
# grub 
########################################### 
d-i grub-installer/with_other_os        boolean true 
 
# reboot 
########################################### 
d-i finish-install/reboot_in_progress   note 
 
# postscript 
########################################### 
d-i preseed/late_command string in-target chroot /target ; in-target wget  

http://HP_SIM_Server_IP_Address/instconfig/db403-agentless/db4.sh ; in-target chmod +x 
db4.sh; in-target sh db4.sh    (continued from previous line) 
########################################### 
 
5. Edit the five instances of HP_SIM_Server_IP_Address, replacing it with the IP address of the HP SIM 

Console Management Server (CMS) you obtained in step 1; these instances are highlighted to 
help you locate them. 

6. Edit the four instances of continued lines. Ensure that the second of the two lines is joined with the 
first and remove the text (continued from previous line). 

7. Save the file and exit the text editor. 

http://hp_sim_server_ip_address/custom/
http://hp_sim_server_ip_address/custom/
http://hp_sim_server_ip_address/custom/
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Step 11: Create Agentless Installation Association Configuration Script 
Debian GNU/Linux is an operating system that is not supported by the ProLiant Service Pack (PSP), so 
you need to create the agentless installation association configuration script. For more information on 
this topic, see the white paper titled Setting up Managed Systems in ICE-Linux without PSPs.   

Follow this procedure to create an agentless installation association configuration script named 
db4.sh: 

1. Determine the IP address of the Ethernet port of the HP SIM server. You will need the IP address in 
step 5. 

2. Change directory to the space for the Debian OS in the Repository: 

# cd /opt/repository/instconfig/db403-agentless 

3. Use the text editor of your choice to create a file named db4.sh. 
4.  Copy the following text and paste it to the text editor buffer. 

#!/bin/sh 
 
########################################### 
# 
# Debian - remove snmpd bind to loopback only  
# 
sed -i 's/ 127.0.0.1//' /etc/default/snmpd 
 
########################################### 
# 
# Debian - add 5 second delay to snmpd start 
#          network isn't ready when snmpd fires 
#          coldstart trap 
# 
sed -i '/ start)/ a\sleep 5' /etc/init.d/snmpd 
 
########################################### 
# 
# Debian - set gdm mouse to no acceleration  
# 
 sed -i '/^exit 0/ i\xset m 1 1' /etc/gdm/Init/Default 
 
########################################### 
# 
# Get Info for HP SIM 
# 
set `dmidecode | grep "Product Name"` 
ProductNM=$3" "$4 
 
set `dmidecode | grep "Product ID"` 
ProductID=${5:0:6} 
 
set `dmidecode | grep "Serial Number"` 
SerialNum=${3:0:11} 
 
########################################### 
# 
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# Make some Info for HP SIM 
# 
HostGUID=$ProductID$SerialNum 
 
########################################### 
# Determine OS for HP SIM 
# 
osname="Debian 4.0 r3 $arch" 
########################################### 
# 
# Assign the OID Info 
# 
 
cat <<EOF2 > /etc/snmp/CntlrAgentLocation.sh  
#!/bin/sh  
echo .1.3.6.1.4.1.232.9.2.2.10.0  
echo integer  
echo 1 
EOF2 
 
cat <<EOF3 > /etc/snmp/ProductName.sh 
#!/bin/sh 
echo .1.3.6.1.4.1.232.2.2.4.2.0 
echo string 
echo "$ProductNM" 
EOF3 
 
cat <<EOF4 > /etc/snmp/MibStatusArray.sh  
#!/bin/sh  
echo .1.3.6.1.4.1.232.11.2.10.1.0  
echo octet_str  
echo "01 02 08 00 00 02 00 00 00 01 00 00 00 00 00 00 00 00 00 00 
00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 02 00 00 00 02 
00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 
00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 01 00 
00 00 00 00 00 00 00 00 00 00" 
EOF4 
 
cat <<EOF5 > /etc/snmp/HostGUID.sh 
#!/bin/sh 
echo .1.3.6.1.4.1.232.11.2.10.3.0 
echo string 
echo "$HostGUID" 
EOF5 
 
cat <<EOF6 > /etc/snmp/OsName.sh 
#!/bin/sh 
echo .1.3.6.1.4.1.232.11.2.2.1.0 
echo string 
echo "$osname" 
EOF6 
 
chmod +x /etc/snmp/CntlrAgentLocation.sh  
chmod +x /etc/snmp/ProductName.sh  
chmod +x /etc/snmp/MibStatusArray.sh  
chmod +x /etc/snmp/HostGUID.sh  
chmod +x /etc/snmp/OsName.sh 
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########################################### 
# 
# Configure SNMP to serve the Info 
# 
 
########################################### 
# 
# HP SIM address 
# 
HPSIM="HP_SIM_Server_IP_Address" 
 
cat - /etc/snmp/snmpd.conf <<EOF > /etc/snmp/snmpd.conf.new 
########################################### 
# 
# HP ICELX authorization 
# 
trapsink $HPSIM 
rocommunity public $HPSIM 
rocommunity 127.0.0.1 
 
########################################### 
# 
# HP ICELX Overrides 
# 
pass .1.3.6.1.4.1.232.9.2.2.10.0 /etc/snmp/CntlrAgentLocation.sh  
pass .1.3.6.1.4.1.232.2.2.4.2.0 /etc/snmp/ProductName.sh  
pass .1.3.6.1.4.1.232.11.2.10.1.0 /etc/snmp/MibStatusArray.sh  
pass .1.3.6.1.4.1.232.11.2.10.3.0 /etc/snmp/HostGUID.sh  
pass .1.3.6.1.4.1.232.11.2.2.1.0 /etc/snmp/OsName.sh  
EOF 
 
mv /etc/snmp/snmpd.conf /etc/snmp/snmpd.conf.old  
mv /etc/snmp/snmpd.conf.new /etc/snmp/snmpd.conf 

5. Replace the instance of HP_SIM_Server_IP_Address with the IP address of the HP SIM server you 
found in Step 1. It is highlighted to help you locate it. 

6. Save the file and exit the text editor. 

Step 12: Installing Debian4-i386 on a Target System 
You can now install the Debian4-i386 operating system on a target managed system. The instructions 
for deploying an operating system to a target managed system are in the section of the HP Insight 
Control Environment for Linux User's Guide titled Generic Procedure for Deploying an OS to One or 
More Managed Systems provides the instructions for deploying an operating system. This section 
supplements the procedure in that Guide. 

You will need the following information before you begin: 

• The (numeric) IP address of the Ethernet port of the HP SIM server. 

Note: Sometimes the system does not obtain a valid DHCP address the first time the system is 
booted. In this case, reboot the system to obtain a valid DHCP address. 
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• The MAC address of the target managed system.  
You can obtain the MAC address for the NIC selected for PXE boot in the BIOS screen through the 
iLO console, or you can get a list of possible MAC addresses from the main iLO web page. 

Follow the procedure to deploy an OS in the HP Insight Control Environment for Linux User's Guide 
with the following modifications: 

• Specify Debian4-i386 when you are prompted to select the operating system. 
• Specify the following kernel append line. Note that, for clarity, the kernel append line is presented 

on four lines, one for each of the variables. You will need to substitute the appropriate values for 
the MAC_Addr and the HP_SIM_Server_IP_Address based on the MAC address of the NIC to PXE 
boot the target system and the IP address of the HP SIM server, respectively. 

DEBCONF_PRIORITY=critical  

preseed=http://HP_SIM_Server_IP_Address/instconfig/db403-agentless/db403-agentless.cfg  

xdevice=MAC_Addr  

init=/macfinder vga=788 –- 

 
 



For more information  
www.hp.com/go/ice-linux 
 
www.debian.org (Debian GNU/Linux) 
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